Chapter 148

Superiority by a Margin Tests for the Difference of Two Within-Subject CV’s in a Parallel Design

Introduction

This procedure calculates power and sample size of superiority by a margin tests for the difference of within-subject coefficients of variation (CV) from a parallel design with replicates (repeated measurements) of a particular treatment. This routine deals with the case in which the statistical hypotheses are expressed in terms of the difference of the within-subject CVs, which is the standard deviation divided by the mean.

Technical Details

This procedure uses the formulation first given by Quan and Shih (1996). The sample size formulas are given in Chow, Shao, Wang, and Lokhnygina (2018).

Suppose $x_{ijk}$ is the response in the $i$th group or treatment ($i = 1, 2$), $j$th subject ($j = 1, \ldots, N_i$), and $k$th measurement ($k = 1, \ldots, M$). The simple one-way random mixed effects model leads to the following estimates of CV1 and CV2

$$\bar{CV}_i = \frac{\hat{\delta}_i}{\hat{\mu}_i}$$

$$\hat{\mu}_i = \frac{1}{N_i M} \sum_{j=1}^{N_i} \sum_{k=1}^{M} x_{ijk}$$

$$\hat{\delta}_i^2 = \frac{1}{N_i (M - 1)} \sum_{j=1}^{N_i} \sum_{k=1}^{M} (x_{ijk} - \bar{x}_{ij})^2$$

where

$$\bar{x}_{ij} = \frac{1}{M} \sum_{k=1}^{M} x_{ijk}$$
Testing Superiority by a Margin

The following hypotheses are usually used to test for the superiority by a margin of CV

\[ H_0: (CV_1 - CV_2) \geq D0 \] versus \[ H_1: (CV_1 - CV_2) < D0. \]

Note that \( D0 \) is assumed to be negative since smaller CVs are ‘better’.

The one-sided test statistic used to test this hypothesis is

\[
T = \frac{(\bar{CV}_1 - \bar{CV}_2) - D0}{\sqrt{\frac{\hat{\sigma}^2_1}{N_1} + \frac{\hat{\sigma}^2_2}{N_2}}}
\]

where \( D0 \) is the hypothesized CV difference under the null hypothesis and

\[
\hat{\sigma}^2_i = \frac{1}{2M} CV_i^2 + CV_i^4
\]

\( T \) is asymptotically distributed as a standard normal random variable.

Hence the null hypothesis is rejected if \( T < z_\alpha \).

**Power**

The power of this combination of tests is given by

\[
\text{Power} = \Phi(z_\alpha - \mu_z)
\]

where

\[
\sigma_i^2 = \frac{1}{2M} CV_i^2 + CV_i^4
\]

and

\[
\mu_z = \frac{(CV_1 - CV_2) - D0}{\sqrt{\frac{\sigma_1^2}{N_1} + \frac{\sigma_2^2}{N_2}}}
\]

where \( \Phi(x) \) is the standard normal CDF.

A simple binary search algorithm can be applied to this power function to obtain an estimate of the necessary sample size.
Procedure Options

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab

The Design tab contains the parameters associated with this test such as sample sizes, alpha, and power.

Solve For

Solve For

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either Power or Sample Size.

Power and Alpha

Power

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal CVs when in fact the CV1 < CV2.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha

This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Often, a value of 0.025 is used for one-sided tests (such as this).

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size (When Solving for Sample Size)

Group Allocation

Select the option that describes the constraints on N1 or N2 or both.

The options are

- Equal (N1 = N2)
  This selection is used when you wish to have equal sample sizes in each group. Since you are solving for both sample sizes at once, no additional sample size parameters need to be entered.

- Enter N2, solve for N1
  Select this option when you wish to fix N2 at some value (or values), and then solve only for N1. Please note that for some values of N2, there may not be a value of N1 that is large enough to obtain the desired power.
• Enter R = N2/N1, solve for N1 and N2
  For this choice, you set a value for the ratio of N2 to N1, and then PASS determines the needed N1 and N2, with this ratio, to obtain the desired power. An equivalent representation of the ratio, R, is
  \[ N2 = R \times N1. \]

• Enter percentage in Group 1, solve for N1 and N2
  For this choice, you set a value for the percentage of the total sample size that is in Group 1, and then PASS determines the needed N1 and N2 with this percentage to obtain the desired power.

**N2 (Sample Size, Group 2)**
This option is displayed if Group Allocation = “Enter N2, solve for N1”

N2 is the number of items or individuals sampled from the Group 2 population.
N2 must be ≥ 2. You can enter a single value or a series of values.

**R (Group Sample Size Ratio)**
This option is displayed only if Group Allocation = “Enter R = N2/N1, solve for N1 and N2.”

R is the ratio of N2 to N1. That is,
\[ R = \frac{N2}{N1}. \]

Use this value to fix the ratio of N2 to N1 while solving for N1 and N2. Only sample size combinations with this ratio are considered.

N2 is related to N1 by the formula:
\[ N2 = \lceil R \times N1 \rceil, \]
where the value \( \lceil Y \rceil \) is the next integer ≥ Y.

For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1 (e.g., \( N1 = 10 \) and \( N2 = 20 \), or \( N1 = 50 \) and \( N2 = 100 \)).

R must be greater than 0. If \( R < 1 \), then N2 will be less than N1; if \( R > 1 \), then N2 will be greater than N1. You can enter a single or a series of values.

**Percent in Group 1**
This option is displayed only if Group Allocation = “Enter percentage in Group 1, solve for N1 and N2.”

Use this value to fix the percentage of the total sample size allocated to Group 1 while solving for N1 and N2. Only sample size combinations with this Group 1 percentage are considered. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single or a series of values.
Sample Size (When Not Solving for Sample Size)

Group Allocation
Select the option that describes how individuals in the study will be allocated to Group 1 and to Group 2.

The options are

- **Equal (N1 = N2)**
  This selection is used when you wish to have equal sample sizes in each group. A single per group sample size will be entered.

- **Enter N1 and N2 individually**
  This choice permits you to enter different values for \( N1 \) and \( N2 \).

- **Enter N1 and \( R \), where \( N2 = R \times N1 \)**
  Choose this option to specify a value (or values) for \( N1 \), and obtain \( N2 \) as a ratio (multiple) of \( N1 \).

- **Enter total sample size and percentage in Group 1**
  Choose this option to specify a value (or values) for the total sample size (\( N \)), obtain \( N1 \) as a percentage of \( N \), and then \( N2 \) as \( N - N1 \).

Sample Size Per Group
*This option is displayed only if Group Allocation = “Equal (N1 = N2).”*

The Sample Size Per Group is the number of items or individuals sampled. Since the sample sizes are the same in each group, this value is the value for \( N1 \), and also the value for \( N2 \).

The Sample Size Per Group must be ≥ 2. You can enter a single value or a series of values.

**N1 (Sample Size, Group 1)**
*This option is displayed if Group Allocation = “Enter N1 and N2 individually” or “Enter N1 and \( R \), where \( N2 = R \times N1 \).”*

\( N1 \) is the number of items or individuals sampled from the Group 1 population.

\( N1 \) must be ≥ 2. You can enter a single value or a series of values.

**N2 (Sample Size, Group 2)**
*This option is displayed only if Group Allocation = “Enter N1 and N2 individually.”*

\( N2 \) is the number of items or individuals sampled from the Group 2 population.

\( N2 \) must be ≥ 2. You can enter a single value or a series of values.

**R (Group Sample Size Ratio)**
*This option is displayed only if Group Allocation = “Enter N1 and \( R \), where \( N2 = R \times N1 \).”*

\( R \) is the ratio of \( N2 \) to \( N1 \). That is,

\[
R = \frac{N2}{N1}
\]

Use this value to obtain \( N2 \) as a multiple (or proportion) of \( N1 \).

\( N2 \) is calculated from \( N1 \) using the formula:

\[
N2 = \lceil R \times N1 \rceil,
\]

where the value \( \lceil Y \rceil \) is the next integer ≥ \( Y \).
For example, setting \( R = 2.0 \) results in a Group 2 sample size that is double the sample size in Group 1. 

\( R \) must be greater than 0. If \( R < 1 \), then \( N2 \) will be less than \( N1 \); if \( R > 1 \), then \( N2 \) will be greater than \( N1 \). You can enter a single value or a series of values.

**Total Sample Size (N)**

*This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”*

This is the total sample size, or the sum of the two group sample sizes. This value, along with the percentage of the total sample size in Group 1, implicitly defines \( N1 \) and \( N2 \).

The total sample size must be greater than one, but practically, must be greater than 3, since each group sample size needs to be at least 4.

You can enter a single value or a series of values.

**Percent in Group 1**

*This option is displayed only if Group Allocation = “Enter total sample size and percentage in Group 1.”*

This value fixes the percentage of the total sample size allocated to Group 1. Small variations from the specified percentage may occur due to the discrete nature of sample sizes.

The Percent in Group 1 must be greater than 0 and less than 100. You can enter a single value or a series of values.

**M (Measurements Per Subject)**

Enter one or more values for \( M \): the number of repeated measurements made on each subject.

You can enter a single value such as 2, a series of values such as 2 3 4, or 2 to 8 by 1.

The range is \( M \geq 2 \).

---

**Effect Size (CV = Coefficient of Variation)**

**Input Type**

Indicate the type of values to enter to specify the coefficients of variation (CV). Regardless of the input type chosen, the test statistics used in the power and sample size calculations are the same. This option is simply given for convenience in specifying the CVs.

The choices are

- **Coefficients of Variation**
  - Enter CV1.0 (Superiority Coef of Variation), CV1.1 (Actual Coef of Variation), and CV2 (Group 2 Coef of Variation)

- **Differences**
  - Enter D0 (Superiority Difference), D1 (Actual Difference), and CV2 (Group 2 Coef of Variation)

**CV1.0 (Superiority Coef of Variation)**

Enter one or more values for the group 1 within-subject coefficient of variation (CV1.0) to be used as the superiority by a margin boundary. If CV1 is greater than this amount, its superiority cannot be concluded at the alpha and power that have been specified.

CV is the within-subject standard deviation divided by the mean.

**Range**

Although, strictly speaking, CVs can be negative since means can be negative, we assume that CVs are \( > 0 \). Typically, \( 0 < CV1.1 < CV1.0 < CV2 \).
Recommended
CV1.0 is usually set slightly below the value of CV2. Their difference represents the superiority margin.

**CV1.1 (Actual Coef of Variation)**
Enter one or more values for within-subject coefficient of variation (CV1) in group 1 under H1. Hence, this is the CV1 at which the power is calculated.
CV is the within-subject standard deviation divided by the mean.
Although, strictly speaking, CVs can be negative since means can be negative, we assume that CVs are > 0.
Typically, 0 < CV1.1 < CV1.0 < CV2.

**D0 (Superiority Difference)**
Enter one or more values for D0, the minimum CV difference (CV1 - CV2) which still results in the conclusion that group 1's CV is not superior to group 2's CV, even though CV1 < CV2. This is often referred to as the **superiority margin**.
CV Definition
CV (coefficient of variation) is the within-subject standard deviation divided by the mean.
Statistical Hypotheses
(Assumes smaller CVs are better)
H0: C1 - C2 ≥ D0 or H0: C1 ≥ C2 + D0
H1: C1 - C2 < D0 or H1: C1 < C2 + D0
where D0 < 0.
Note that D1 < D0 < 0.

**D1 (Actual Difference)**
Enter one or more values for the actual difference (CV1-CV2). Hence, this is the difference at which the power is calculated.
CV (coefficient of variation) is the within-subject standard deviation divided by the mean.
D1 is in the same scale as D0 and CV2.
D1 can be any number, positive, negative, or zero.
Usually, D1 < D0 < 0.
You can enter a single value such as -0.3, a list of values such as -0.1 -0.2 -0.3, or a range of values such as -0.9 to -0.3 BY 0.1.

**CV2 (Group 2 Coef of Variation)**
Enter one or more values for within-subject coefficient of variation (CV2) in group 2. It is used to define CV2 for both H0 and H1.
CV is the within-subject standard deviation divided by the mean.
Although, strictly speaking, CVs can be negative since means can be negative, we assume that CVs are positive (> 0).
Example 1 – Finding Sample Size

A company has developed a generic drug for treating rheumatism and wants to show that its within-subject CV is superior by a margin to a reference drug. A parallel design with 2 repeated measurements per subject will be used.

Company researchers set the significance level to 0.05, the power to 0.90, CV2 to 0.5, D0 to 0.4, and D1 to -0.30 -0.25 -0.20 -0.15. They want to investigate the range of required sample size values assuming that the two group sample sizes are equal.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for the Difference of Two Within-Subject CV’s in a Parallel Design procedure window. You may then make the appropriate entries as listed below, or open Example I by going to the File menu and choosing Open Example Template.

Option

Design Tab
Solve For ................................................ Sample Size
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Group Allocation ................................. Equal (N1 = N2)
M (Measurements Per Subject) .............. 2
Input Type ............................................. Differences
D0 (Superiority Difference) .................... -0.1
D1 (Actual Difference) ............................ -0.30 -0.25 -0.20 -0.15
CV2 (Group 2 Coef of Variation) ............ 0.5

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Actual Power</th>
<th>Grp 1 Sample Size</th>
<th>Grp 2 Sample Size</th>
<th>Meas Per Subj</th>
<th>Super CV Value</th>
<th>Actual CV Value</th>
<th>Grp 2 CV - CV2</th>
<th>CV1.0 - CV2</th>
<th>CV1.1 - CV2</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9064</td>
<td>30</td>
<td>30</td>
<td>60</td>
<td>2</td>
<td>0.400</td>
<td>0.200</td>
<td>-0.100</td>
<td>-0.300</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9045</td>
<td>56</td>
<td>56</td>
<td>112</td>
<td>2</td>
<td>0.400</td>
<td>0.250</td>
<td>-0.100</td>
<td>-0.250</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9014</td>
<td>134</td>
<td>134</td>
<td>268</td>
<td>2</td>
<td>0.400</td>
<td>0.300</td>
<td>-0.100</td>
<td>-0.200</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9002</td>
<td>585</td>
<td>585</td>
<td>1170</td>
<td>2</td>
<td>0.400</td>
<td>0.350</td>
<td>-0.100</td>
<td>-0.150</td>
<td>0.050</td>
</tr>
</tbody>
</table>

References

Quan, H. and Shih, W.J. 1996. ‘Assessing reproducibility by the within-subject coefficient of variation with random effects models’. Biometrics, 52, pages 1195-1203.
Report Definitions
One-Sided Hypotheses: $H_0$: $CV_1 - CV_2 \geq D_0$ vs. $H_1$: $CV_1 - CV_2 < D_0$ where $D_0 < 0$
Power is the probability of rejecting a false null hypothesis.
$N_1$ is the number of subjects from group 1. Each subject is measured $M$ times.
$N_2$ is the number of subjects from group 2. Each subject is measured $M$ times.
$N$ is the total number of subjects. $N = N_1 + N_2$.
$M$ is the number of measurements per subject.
$CV_{1.0}$ is the superiority boundary. $CV$s below this value are concluded as superior.
$CV_{1.1}$ is the actual $CV$ of group 1 at which the power is calculated (the value of $CV_1$ assumed by $H_1$).
$CV_2$ is the within-subject coefficient of variation in group 2 assumed by both $H_0$ and $H_1$.
$D_0$ is the superiority difference ($CV_{1.0} - CV_2$).
$D_1$ is the actual difference ($CV_{1.1} - CV_2$) at which the power is calculated (assumed by $H_1$).
Alpha is the probability of rejecting a true null hypothesis, $H_0$.

Summary Statements
A study is being conducted to test the superiority by a margin of a particular group (group 1) compared to a reference group (group 2) with regards to their within-subject coefficients of variation ($CV$s). Group sample sizes of 30 and 30 achieve 91% power to reject the null hypothesis that the $CV$ difference is greater than or equal to the superiority margin -0.100 at a significance level of 0.050. The superiority boundary of the $CV$ of group 1 is 0.400. The actual value of the $CV$ of group 1 assumed by the alternative hypothesis is 0.200. The $CV$ of group 2 is 0.500. The difference in $CV$ at which the power is calculated is -0.300. Each subject is measured 2 times.

This report gives the sample sizes for the indicated scenarios.

Plot Section

This plot shows the relationship between sample size and $D_1$. 
Example 2 – Validation using Hand Calculations

We could not find a validation example in the literature, so we will validate this procedure with an example calculated by hand using the formulas given earlier.

Suppose CV1.1 = 0.5, CV1.0 = 0.6, CV2 = 0.7, M = 2, alpha = 0.05, and N1 = N2 = 302. This leads to $\sigma_1^2 = 0.125$ and $\sigma_2^2 = 0.3626$.

The power calculations proceed as follows

$$\mu_z = \frac{(0.5 - 0.7) - (-0.1)}{\sqrt{\frac{0.125}{302} + \frac{0.3626}{302}}} = \frac{-0.1}{0.0401817} = -2.4886947$$

Hence

$$\text{Power} = \Phi(z_{\alpha} - \mu_z) = \Phi(-1.6448536 + 2.4886947) = 0.8006.$$  

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for the Difference of Two Within-Subject CV’s in a Parallel Design procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>Group Allocation</td>
<td>Equal (N1 = N2)</td>
</tr>
<tr>
<td>Sample Size Per Group</td>
<td>302</td>
</tr>
<tr>
<td>M (Measurements Per Subject)</td>
<td>2</td>
</tr>
<tr>
<td>Input Type</td>
<td>Coefficients of Variation</td>
</tr>
<tr>
<td>CV1.0 (Superiority Coef of Variation)</td>
<td>0.6</td>
</tr>
<tr>
<td>CV1.1 (Actual Coef of Variation)</td>
<td>0.5</td>
</tr>
<tr>
<td>CV2 (Group 2 Coef of Variation)</td>
<td>0.7</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Numeric Results</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>One-Sided Hypotheses: H0: CV1 - CV2 ≥ D0 vs. H1: CV1 - CV2 &lt; D0 where D0 &lt; 0</td>
<td></td>
</tr>
<tr>
<td>Power</td>
<td>0.8006</td>
</tr>
<tr>
<td>Grp 1 Sample Size</td>
<td>302</td>
</tr>
<tr>
<td>Grp 2 Sample Size</td>
<td>302</td>
</tr>
<tr>
<td>N</td>
<td>604</td>
</tr>
<tr>
<td>N1</td>
<td>2</td>
</tr>
<tr>
<td>Super CV1</td>
<td>0.600</td>
</tr>
<tr>
<td>Actual CV1</td>
<td>0.500</td>
</tr>
<tr>
<td>Grp 2 CV</td>
<td>0.700</td>
</tr>
<tr>
<td>CV1.0 - CV2</td>
<td>-0.100</td>
</tr>
<tr>
<td>CV1.1 - CV2</td>
<td>-0.200</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.050</td>
</tr>
</tbody>
</table>

The power matches the hand calculations.